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Micro Focus Visual COBOL 2.2 Update 1 for
ISVs Release Notes

The Micro Focus Visual COBOL for ISVs package comprises the following products which you can
download from your Electronic Product Delivery Note:

• Visual COBOL for Visual Studio - delivers the richest development experience for COBOL programming
available on Windows using either Microsoft's Visual Studio 2010 or Visual Studio 2012 integrated
development environments. Visual COBOL supports the development and deployment of both
managed .NET and native code applications.

Note: The product is available in two variants - Visual COBOL for Visual Studio 2010, and Visual
COBOL for Visual Studio 2012.

Visual COBOL for Visual Studio 2010 and Visual COBOL for Visual Studio 2012 each target a
different version of the COBOL run-time system - COBOL Server 2010 and COBOL Server 2012
respectively.

Ensure that after you've edited the project in the preferred version of Visual Studio, you compile
your source code in that version of Visual COBOL which targets the version of the COBOL run-
time in which you want your applications to run.

For example, if you build your application using Visual COBOL for Visual Studio 2010 you cannot
deploy the target files to COBOL Server 2012; you must use COBOL Server 2010.

• Visual COBOL for Eclipse - provides an Eclipse-based integrated COBOL development environment for
Windows or Linux. Provides COBOL JVM support and enhanced compatibility with ACUCOBOL. Can
be used standalone for developing local applications or in conjunction with the Development Hub to
develop remote projects in Linux and UNIX.

• Visual COBOL Development Hub - provides a rich desktop development environment based on the
Eclipse IDE with high-performance server-based tools for managing builds, source code access and
debugger engine. The Development Hub also provides a central administration site, simplifying the
development tool distribution and maintenance process.

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you
are upgrading to this release from an earlier version of Visual COBOL, you may need to apply for a
new authorization code in order to access the functionality - please contact Micro Focus SupportLine
to receive an updated authorization code. Note that the Visual COBOL Personal Edition license does
not support the IMTK functionality.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Important: Application executables that were compiled using earlier Micro Focus products must be
recompiled from the sources using Visual COBOL.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.
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System Requirements

System Requirements for Visual COBOL for Visual Studio

Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Microsoft Visual Studio.
See the Visual Studio documentation for details of the Microsoft requirements.

The disk space requirements are, approximately:

Platform Visual COBOL Sentinel RMS License Manager

x86 Windows platforms 250MB 25MB

x64 Windows platforms 350MB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: If you are using Visual COBOL on a 64-bit operating system, you can produce either 32-bit or
64-bit applications.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• Visual COBOL for Visual Studio 2012 is not supported on versions of Windows earlier than
Windows 7.

• The Enterprise Server feature is not supported on Windows XP.

Software Requirements

Visual Studio IDE

This product requires any of the following versions of Visual Studio:

• A full version of Microsoft Visual Studio 2010 or 2012 Premium, Professional, or Ultimate edition, or the
respective version of Microsoft's Visual Studio Integrated Shell.

Note:

• Microsoft Visual Studio Express Edition is not supported.
• You can download the Visual Studio Integrated Shell from the Microsoft Download Center. If

you choose to install the Shell, ensure you run the installer to complete the installation - run
vsintshell.enu.exe from the location where you installed the download.

• If you do not have any of these versions of Visual Studio installed, the setup file will install the Visual
Studio Integrated Shell.
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• Microsoft Windows SDK is required if you are using the Visual Studio Shell. See the Microsoft
Download Center and search for Windows SDK.

• Microsoft .NET Framework 4.0. This is included with the above versions of Visual Studio.
• Microsoft .NET Framework 4.5. This is included with Visual Studio 2012.

Note:

• Visual Studio 2010 Service Pack 1 is required if you are using Visual COBOL for Visual Studio
2010 and Visual COBOL for Visual Studio 2012 on the same machine. If you are connected to the
Internet, the setup file downloads and installs Visual Studio 2010 Service Pack 1 automatically. If
you do not have Internet access, you need to download Visual Studio 2010 Service Pack 1 on a
machine that has Internet connection, and then copy the installer to your machine.

• In addition, when building a native COBOL project that contains resources you must replace the
cvtres.exe in the bin and bin64 directories of your Visual COBOL installation with the version
of the file which gets installed with Visual Studio 2010 SP1. You can download Service Pack 1 for
Visual Studio 2010 from the Microsoft Download Center.

Other Requirements

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse
(Windows)

Hardware Requirements
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are, approximately:

Platform Visual COBOL Sentinel RMS License Manager

x86 Windows platforms 1.05GB 25MB

x64 Windows platforms 1.2GB 25MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.
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For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: The Enterprise Server feature is not supported on Windows XP.

Software requirements

The setup file will check your machine for whether the prerequisite software is installed and will install any
missing prerequisites and the product components.

If no Java is installed on your machine, the setup file installs Java 1.6u27.

If you are installing Visual COBOL on a machine that has Java 7 or Java 8 installed, see the Java Support
in the Known Issues and Restrictions section in your product help for considerations that apply to using the
Eclipse IDE.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL for Eclipse
(UNIX)

Hardware Requirements for Visual COBOL for Eclipse
Visual COBOL has the following requirements in addition to the requirements of Eclipse. See the Eclipse
documentation for details of its requirements.

The disk space requirements are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

x86-64 running
Red Hat Linux

710 2.84 1.42 40

x86-64 running
SuSE SLES

714 2.87 1.43 40
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Operating Systems Supported
Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x, you must have the following operating system libraries installed:

All Visual COBOL products
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries for Visual
COBOL for Eclipse

PackageKit-gtk-module-*.x86_64
PackageKit-gtk-module-*.i686
gtk2-*.x86_64
gtk2-*.i686
gtk2-engines.*.x86_64
gtk2-engines.*.i686
libXtst-*.x86_64
libXtst-*.i686
libcanberra-gtk2-*.x86_64
libcanberra-gtk2-*.i686
webkitgtk.x86_64
webkitgtk.i686
xterm (any version)
libgnome.x86_64
libgnome.i686

Additional libraries required to
use the core_on_error runtime
variable

gdb - the gdb packages (for the GNU Project Debugger) can be
installed from the install media for your OS.

Additional libraries for Micro
Focus Visual COBOL
Development Hub

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Visual COBOL Development Hub
glibc-devel-*.s390
glibc-devel-*.s390x

System Requirements | 9

http://supportline.microfocus.com/prodavail.aspx


Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to run the Eclipse IDE, to
execute COBOL JVM code and for native COBOL and Java interoperability. The earliest supported
release of Java 6 is 1.6 Update 27. You can download Oracle's Java EE from Oracle's Web site and
install it anywhere on your machine.

Note: On Linux, the 32-bit version of Java is required to install and use Visual COBOL for Eclipse.
When you start the installation, if the 64-bit version of Java is already installed on your Linux
machine, you might not be able to install Visual COBOL. This is a known issue with the Oracle
Java installers for Linux which prevent you from installing both the 32-bit and the 64-bit versions of
Java on the same machine. To work around this problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle Web site.
• Untar the distribution into a location different from the one used for the 64-bit Java version. For

example, untar in /usr/local/java32 and not in /usr/local/java.
• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is used to

install and run Visual COBOL.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

System Requirements for Visual COBOL Development
Hub

Hardware Requirements for Micro Focus Visual
COBOL Development Hub
The disk space requirements are approximately:
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Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running
AIX

361 1.44 722 33

HP IA 695 2.7 1390 61

System Z running
Red Hat Linux

315 1.26 630 34

x86-64 running
Red Hat Linux

324 1.3 648 40

SPARC running
Solaris

370 1.48 740 38

x86-64 running
Solaris

346 1.38 692 30

System Z running
SuSE SLES

319 1.28 638 34

x86-64 running
SuSE SLES

328 1.31 656 40

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x, you must have the following operating system libraries installed:

All Visual COBOL products
glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

Additional libraries for Visual
COBOL for Eclipse

PackageKit-gtk-module-*.x86_64
PackageKit-gtk-module-*.i686
gtk2-*.x86_64
gtk2-*.i686
gtk2-engines.*.x86_64
gtk2-engines.*.i686
libXtst-*.x86_64
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libXtst-*.i686
libcanberra-gtk2-*.x86_64
libcanberra-gtk2-*.i686
webkitgtk.x86_64
webkitgtk.i686
xterm (any version)
libgnome.x86_64
libgnome.i686

Additional libraries required to
use the core_on_error runtime
variable

gdb - the gdb packages (for the GNU Project Debugger) can be
installed from the install media for your OS.

Additional libraries for Micro
Focus Visual COBOL
Development Hub

glibc-devel-*.x86_64
glibc-devel-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

Additional libraries for Micro Focus Visual COBOL Development Hub
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Xterm, the terminal emulator for the X Window System, is part of your UNIX/Linux distribution but is not
installed by default. Use your UNIX/Linux installation media to install it.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from www.oracle.com and install it anywhere on your
machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the JAVA_HOME environment variable. When installing the product, set this variable to
a 32-bit Java installation or the installation terminates. For example, execute the following:

JAVA_HOME=java_install_dir

where java_install_dir is the path to the JAVA installation directory such as /usr/java/javan.n
• You need to add $JAVA_HOME/bin to your system PATH variable. To do this, execute:

export PATH=$JAVA_HOME/bin:$PATH

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
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Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.
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Installation

Installing Visual COBOL for Visual Studio

Installation restrictions and requirements
Before starting the installation you should consider the following:

• If, when you install Visual COBOL for Visual Studio 2010, the machine does not have Microsoft Visual C
++ 2010 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ 2010 Redistributable Runtime adds a number of .dll files, without
digital signatures, into the winsxs directory.

• If, when you install Visual COBOL for Visual Studio 2012, the machine does not have Microsoft Visual C
++ 2012 Redistributable Runtime already installed, it is installed as required by Visual COBOL. The
installation of Microsoft Visual C++ Redistributable Runtime adds a number of .dll files, without digital
signatures, into the winsxs directory.

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation. Also, the Visual Studio Help Viewer must not be opened.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  Visual COBOL command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

14 | Installation



MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

You can download Visual COBOL for Visual Studio 2012 from the Micro Focus SupportLine Web site and
from the Product Updates section.

Installing Visual COBOL for Visual Studio
Note: Before installing this release as an upgrade to an existing installation of the previous version 2.2
of the product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might
result in files not being installed.

To install this product:

1. Run the vcvs2010_22.exe (or vcvs2012_22.exe when installing the product for Visual Studio
2012) file and follow the wizard instructions to install the prerequisite software and the product.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a Microsoft's known problem. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing as an Upgrade
This release will update existing installations of Visual COBOL 2.2.

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
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backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

After Installing
You are now ready to run Visual COBOL. From the Windows taskbar click Start > All Programs > Micro
Focus Visual COBOL > Visual COBOL for Visual Studio nnnn.

Note: The Start menu is not available on Windows 8 and Windows Server 2012. You use the Start
screen to invoke programs.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:

Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2
Update1.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Please refer to the Start Here and Product Information sections in your product Help. Here, you will find
information on getting started including tutorials and demonstration programs.

Note:

• The first release of Visual Studio 2010 has a browser-based help system, Microsoft Help Viewer
1.0, which does not include an index for the locally-installed help. Navigation of the content is only
available using the table of contents and Search and the help contents for the Help system does
not expand and collapse in the same way as previous Help systems.

• If you have problems trying to view the Micro Focus help, ensure that the Visual Studio Help
Library is pointing to local help. From the Visual Studio menu click Help > Manage Help Systems
> Choose online or local help and check the I want to use local help button.

• Visual Studio 2010 SP1 provides an upgrade of the help system, Microsoft Help Viewer 1.1, which
provides a stand-alone help viewer with an index and a fully expandable table of contents.

• If you do not want to install Visual Studio 2010 SP1, you can install some third-party tools that
enable the index or the fully expanding table of contents. For more information, see the topic Help
on Help.

• To view the help in Visual Studio 2012, ensure that the Visual Studio Help Library is pointing to
local help. From the Visual Studio menu click Help > Set Help Preferences > Launch in Help
Browser.

• For full details of the Visual Studio 2012 Help system, see the locally installed Microsoft Help
Viewer 2.0 Help, which is available from Help menu in the IDE.

• On Windows 8 and Windows Server 2012, an issue with Microsoft Help Viewer 2.0 and Internet
Explorer's security being turned on can cause the Help content to be displayed as raw HTML
code. To resolve the issue, you need to turn off the Internet Explorer Enhanced Security
Configuration (IE ESC) for both administrators and users. Check the Microsoft Windows help for
more information on how to do this.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
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2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL and Micro Focus
License Administration. Uninstalling only Visual COBOL does not automatically uninstall the Micro
Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Some registry entries are not removed by the uninstallation process and you need to manually delete
them.

The following folders might not be removed:

• The Micro Focus Product Name folder in the Start menu - you can delete it manually.
• %systemdrive%\Users\Public\Documents\Micro Focus - includes the binaries and the log

files of the samples which you have built.
• %ProgramData%\Micro Focus - includes some data files used by the Micro Focus licensing system.
• %Program Files%\Micro Focus - you can delete it manually.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

In addition, the following registry entries are not removed. These are created the first time that an
Enterprise Server that has been enabled for performance monitoring starts up:

• Micro Focus Server\Performance\Active Servers
• Micro Focus Server\Performance\PerfIniFile

Installing Visual COBOL for Eclipse (Windows)
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Installation restrictions and requirements
Before starting the installation, you should consider the following:

• Visual COBOL and COBOL Server cannot coexist on the same machine.
• Visual COBOL and Enterprise Developer cannot coexist on the same machine.

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing as an Upgrade
This release will update an existing installation of Visual COBOL 2.2.

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of the
product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might result in files
not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Installing
Note:

• Before installing, check Installation Restrictions and Requirements.
• See Installing as an Upgrade first for important information when upgrading an existing installation

of Visual COBOL.
• This version of the product is a full install.

These are the steps to install this product:

1. Run the vce_221.exe file and follow the wizard instructions to complete the installation.

By default, this installs Visual COBOL in the %ProgramFiles(x86)%\Micro Focus\Visual COBOL
folder and installs a full version of Eclipse 3.8, with the Micro Focus plugins already installed, in the C:
\Users\Public\Micro Focus\Product Name\eclipse directory. On older versions of Windows,
Eclipse might be installed in a different folder, such as for Windows XP, in %ProgramFiles(x86)%
\Micro Focus\Visual COBOL\eclipse.

Note:

• When the installation has completed, on some editions of Windows you might receive a notification
that Visual Studio 2012 has compatibility issues. This is a Microsoft's known problem. To resolve it,
follow the instructions in the notification for obtaining help online, or download the KB2781514
update for Visual Studio 2012 from the Microsoft Download Center.

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
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computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for Visual Studio and the .NET Framework that are
available at the Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL but you can install it if you wish.

Installing into different Eclipse packages
Micro Focus Visual COBOL uses Eclipse 3.8, but it will also work with Eclipse 3.7.1. If you want to use
Visual COBOL in Eclipse packages based on version 3.7.1, you must also install the Visual COBOL update
site, and the RSE and AspectJ plugins. The following sections show how to install into an existing
installation of Eclipse 3.8 and into Eclipse 3.7.1.

Important: We recommend you back up all existing Eclipse configuration files first.

If you have Java 7 or Java 8 installed on your machine, see the Java Support considerations in the
Known Issues and Restrictions section in your product help.

Installing into Eclipse 3.8

1. Install Visual COBOL.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

a. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Visual COBOL\installer (Windows) or /opt/microfocus/<product>/eclipse (UNIX) to
a temporary folder:

ajdt_2.2.2_for_eclipse_4.2.zip

dtp_1.10.2.zip

emf-runtime-2.8.3.zip

emf-transaction-runtime-1.6.0M7.zip

emf-validation-runtime-1.6.0M7.zip

GEF-runtime-3.8.2.zip

org.eclipse.graphiti.site_0.9.2.201302110913.zip

RSE-runtime-3.5-GA.zip

wtp4x-R-3.4.2-20130208151217.zip

xsd-runtime-2.8.3.zip

b. Extract the contents of the following .zip file in %ProgramFiles(x86)%\Micro Focus\Visual
COBOL (Windows) or /opt/microfocus/<product>/eclipse (UNIX) into the same temporary
folder:

UpdateSite.zip

c. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
<your existing Eclipse>/eclipse/dropins (UNIX).

d. Rename each of the following folders:

• From ajdt_2.2.2_for_eclipse_4.2 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
• From UpdateSite to COBOLUpdateSite
• From dtp_1.10.2/eclipse to DTPUpdateSite
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• From emf-runtime-2.8.3/eclipse to EMFUpdateSite
• From emf-transaction-runtime-1.6.0M7/eclipse to EMFTransactionUpdateSite
• From emf-validation-runtime-1.6.0M7/eclipse to EMFValidationUpdateSite
• From GEF-runtime-3.8.2/eclipse to GEFUpdateSite
• From org.eclipse.graphiti.site_0.9.2.201302110913/eclipse to

GraphitiUpdateSite

• From wtp4x-R-3.4.2-20130208151217/eclipse to WTPUpdateSite
• From xsd-runtime-2.8.3/eclipse to XSDUpdateSite

e. Edit the eclipse.ini file in <your existing Eclipse>\eclipse (Windows) or <your
existing Eclipse>/eclipse (UNIX):

• Add

Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20130127-2000.jar

as a property at the end of the file
• Add

Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/
org.eclipse.equinox.weaving.aspectj_1.0.200.I20130127-2000.jar@2:start,
reference:file:
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.301.v20120914-163612.jar@1

as a property at the end of the file.

Note: There is an eclipse.ini file in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\installer (Windows) or $COBDIR (UNIX) folder but it might conflict with the existing
eclipse.ini in your existing installation. You need to decide which pieces are relevant.

3. Restart Eclipse at the command line with the -clean option.

Installing into Eclipse 3.7.1

1. Install Visual COBOL.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

1. From the http://www.eclipse.org website, locate the following packages from the project download
archive:

• ajdt_2.2.2_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
<your existing Eclipse>/eclipse/dropins (UNIX).

3. Rename each of the folders:

• From ajdt_2.2.2_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite

4. Move the contents of the <your existing Eclipse>\eclipse\dropins\RSEUpdateSite
\eclipse (Windows) or <your existing Eclipse>/eclipse/dropins/RSEUpdateSite/
eclipse (UNIX) folder up a level (that is, to <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite (Windows) or <your existing Eclipse>/eclipse/dropins/
RSEUpdateSite (UNIX)) and delete the empty folder.

5. Extract UpdateSite.zip from %ProgramFiles(x86)%\Micro Focus\Visual COBOL (Windows)
or $COBDIR/eclipse (UNIX) into <your existing Eclipse>\eclipse\dropins
\COBOLUpdateSite (Windows) or <your existing Eclipse>/eclipse/dropins/
COBOLUpdateSite (UNIX).
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6. You might need to edit the eclipse.ini file in <your existing Eclipse>\eclipse
(Windows) or <your existing Eclipse>/eclipse (UNIX):

• Add

-Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/ 
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20120427-0800.jar 

as a property at the end of the file
• Add

-Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/ 
org.eclipse.equinox.weaving.aspectj_1.0.100.I20120427-0800.jar@2:start,
reference:file: 
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.200.v20110502-1955.jar@1:sta
rt

as a property at the end of the file
3. Restart Eclipse at the command line with the -clean option.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
3. Click Window > Reset Perspective.
4. Click OK.
5. Reapply any customizations.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:

Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2
Update1.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Installing X Windows on Windows
Some features of Visual COBOL for Eclipse on Windows require an X Windows installation, hence Micro
Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in your
Visual COBOL installation. By default this will be in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.
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To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:

1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling

Windows

To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Visual COBOL and Micro
Focus License Administration. Uninstalling only Visual COBOL does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

UNIX and Linux Installer Issues
Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for
Eclipse. When you start the installation, if the 64-bit version of Java is already installed
on your Linux machine, you might not be able to install Visual COBOL. This is a known
issue with the Oracle Java installers for Linux which prevent you from installing both the
32-bit and the 64-bit versions of Java on the same machine. To work around this
problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.
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• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Visual COBOL.

License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

Installation | 23



disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License
Server

You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Installing Visual COBOL for Eclipse (UNIX)

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing

Installing as an upgrade
This release works concurrently with the previous version of Visual COBOL, so you do not need to uninstall
it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOLEclipse,
by default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOLEclipse /opt/microfocus/
VisualCOBOLEclipseversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Visual COBOL installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOLEclipse"
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Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing into different Eclipse packages
Micro Focus Visual COBOL uses Eclipse 3.8, but it will also work with Eclipse 3.7.1. If you want to use
Visual COBOL in Eclipse packages based on version 3.7.1, you must also install the Visual COBOL update
site, and the RSE and AspectJ plugins. The following sections show how to install into an existing
installation of Eclipse 3.8 and into Eclipse 3.7.1.

Important: We recommend you back up all existing Eclipse configuration files first.

If you have Java 7 or Java 8 installed on your machine, see the Java Support considerations in the
Known Issues and Restrictions section in your product help.

Installing into Eclipse 3.8

1. Install Visual COBOL.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

a. Extract the contents of the following .zip files in %ProgramFiles(x86)%\Micro Focus
\Visual COBOL\installer (Windows) or /opt/microfocus/<product>/eclipse (UNIX) to
a temporary folder:

ajdt_2.2.2_for_eclipse_4.2.zip

dtp_1.10.2.zip

emf-runtime-2.8.3.zip

emf-transaction-runtime-1.6.0M7.zip

emf-validation-runtime-1.6.0M7.zip

GEF-runtime-3.8.2.zip

org.eclipse.graphiti.site_0.9.2.201302110913.zip

RSE-runtime-3.5-GA.zip

wtp4x-R-3.4.2-20130208151217.zip

xsd-runtime-2.8.3.zip

b. Extract the contents of the following .zip file in %ProgramFiles(x86)%\Micro Focus\Visual
COBOL (Windows) or /opt/microfocus/<product>/eclipse (UNIX) into the same temporary
folder:

UpdateSite.zip

c. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
<your existing Eclipse>/eclipse/dropins (UNIX).

d. Rename each of the following folders:

• From ajdt_2.2.2_for_eclipse_4.2 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite
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• From UpdateSite to COBOLUpdateSite
• From dtp_1.10.2/eclipse to DTPUpdateSite
• From emf-runtime-2.8.3/eclipse to EMFUpdateSite
• From emf-transaction-runtime-1.6.0M7/eclipse to EMFTransactionUpdateSite
• From emf-validation-runtime-1.6.0M7/eclipse to EMFValidationUpdateSite
• From GEF-runtime-3.8.2/eclipse to GEFUpdateSite
• From org.eclipse.graphiti.site_0.9.2.201302110913/eclipse to

GraphitiUpdateSite

• From wtp4x-R-3.4.2-20130208151217/eclipse to WTPUpdateSite
• From xsd-runtime-2.8.3/eclipse to XSDUpdateSite

e. Edit the eclipse.ini file in <your existing Eclipse>\eclipse (Windows) or <your
existing Eclipse>/eclipse (UNIX):

• Add

Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20130127-2000.jar

as a property at the end of the file
• Add

Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/
org.eclipse.equinox.weaving.aspectj_1.0.200.I20130127-2000.jar@2:start,
reference:file:
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.301.v20120914-163612.jar@1

as a property at the end of the file.

Note: There is an eclipse.ini file in the %ProgramFiles(x86)%\Micro Focus\Visual
COBOL\installer (Windows) or $COBDIR (UNIX) folder but it might conflict with the existing
eclipse.ini in your existing installation. You need to decide which pieces are relevant.

3. Restart Eclipse at the command line with the -clean option.

Installing into Eclipse 3.7.1

1. Install Visual COBOL.
2. Copy the required Visual COBOL resources to your existing Eclipse as follows:

1. From the http://www.eclipse.org website, locate the following packages from the project download
archive:

• ajdt_2.2.2_for_eclipse_3.7.zip

• RSE-runtime-3.3.zip

2. Copy the extracted folders to <your existing Eclipse>\eclipse\dropins (Windows) or
<your existing Eclipse>/eclipse/dropins (UNIX).

3. Rename each of the folders:

• From ajdt_2.2.2_for_eclipse_3.7 to AJDTUpdateSite
• From RSE-runtime-3.3 to RSEUpdateSite

4. Move the contents of the <your existing Eclipse>\eclipse\dropins\RSEUpdateSite
\eclipse (Windows) or <your existing Eclipse>/eclipse/dropins/RSEUpdateSite/
eclipse (UNIX) folder up a level (that is, to <your existing Eclipse>\eclipse\dropins
\RSEUpdateSite (Windows) or <your existing Eclipse>/eclipse/dropins/
RSEUpdateSite (UNIX)) and delete the empty folder.

5. Extract UpdateSite.zip from %ProgramFiles(x86)%\Micro Focus\Visual COBOL (Windows)
or $COBDIR/eclipse (UNIX) into <your existing Eclipse>\eclipse\dropins
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\COBOLUpdateSite (Windows) or <your existing Eclipse>/eclipse/dropins/
COBOLUpdateSite (UNIX).

6. You might need to edit the eclipse.ini file in <your existing Eclipse>\eclipse
(Windows) or <your existing Eclipse>/eclipse (UNIX):

• Add

-Dosgi.framework.extensions=reference:file:../dropins/AJDTUpdateSite/ 
plugins/org.eclipse.equinox.weaving.hook_1.0.200.I20120427-0800.jar 

as a property at the end of the file
• Add

-Dosgi.bundles=reference:file:../dropins/AJDTUpdateSite/plugins/ 
org.eclipse.equinox.weaving.aspectj_1.0.100.I20120427-0800.jar@2:start,
reference:file: 
../plugins/
org.eclipse.equinox.simpleconfigurator_1.0.200.v20110502-1955.jar@1:sta
rt

as a property at the end of the file
3. Restart Eclipse at the command line with the -clean option.

After Installing
If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installing any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1. Open the existing workspace with this product.

You may receive some warnings or errors which you can ignore.
2. Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.
3. Click Window > Reset Perspective.
4. Click OK.
5. Reapply any customizations.

Configuring the Environment for Developing RDBMS
Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT
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Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLEclipse2.2.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

Installing Visual COBOL Development Hub

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.

By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

These are the steps to install this product:

1. Give execute permissions to the setup file:

chmod +x setup_visualcobol_devhub_2.2_update1_platform
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2. Run the installer with superuser permissions:

./setup_visualcobol_devhub_2.2_update1_platform

If you don't run this as superuser you will be prompted to enter the superuser password during the
installation.

The COBOL environment is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_visualcobol_devhub_2.2_update1_platform -installlocation="full path 
of new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For example,
the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running
on your machine. During installation licensing is shutdown to allow files to be updated. To
ensure the processes running on your machine are not affected, you need to use the -
skipsafenet option, which skips the installation of SafeNet:

./setup_visualcobol_devhub_2.2_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty
file named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file
and install Sentinel RMS server manually.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V
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Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Note: For information about the Micro Focus Visual COBOL Development Hub, check the help for
Visual COBOL for Eclipse that is available online on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with the previous version of Micro Focus Visual COBOL Development
Hub, so you do not need to uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable (/opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

Micro Focus Visual COBOL Development Hub installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Configuring the Environment for Developing RDBMS
Applications on UNIX

Note:

• If you are working with remote projects, you need to configure the environment before you start the
remote server process.

• On UNIX, if you are working with local projects, you need to configure the environment before you
start Eclipse.

1. Ensure the COBOL and the third-party software environments are set.
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2. Set up the RDBMS environment.

Refer to your RDBMS vendor documentation for details.
3. Set COBCPY as required in order for the IDE to locate any copybooks that are external to your project.
4. If working with Pro*COBOL/Cobsql applications you need to set COBOPT. This sets the appropriate

linker options for the platform and the COBOL working mode:

To do this, execute the following at the command line:

$COBDIR/src/oracle/set_cobopt_oracle
COBOPT=$PWD/cobopt.ora
export COBOPT

Configuring the Remote System Explorer Support
The remote development support from the Eclipse IDE relies upon Visual COBOL Development Hub
running on the UNIX machine and handling all requests from the IDE for building and debugging programs.
Visual COBOL Development Hub provides a UNIX daemon, the Remote Development Option (RDO)
daemon, which initiates the RDO as Eclipse clients connect to it. Whichever environment is used to start
the RDO daemon will be inherited for all servers and hence all build and debug sessions.

Configuring the Environment

You may need to configure some aspects of the environment before you start the daemon. This is because
when a build or debug session is initiated on the Development Hub from one of the Eclipse clients, the
environment used will be inherited from whatever was used to start the daemon. A typical example of the
kind of environment that might need to be set up would include database locations and settings for SQL
access at build/run time.

Starting the Daemon

Important: Before starting the daemon you must have the following on your UNIX machine:

• a version of Perl
• a version of Java
• the as (assembler) and ld (linking) programs on the path, as specified by the PATH environment

variable

To start the daemon on the default port (4075) as a background process, perform this command with
superuser authority:

$COBDIR/remotedev/startrdodaemon

The daemon will now listen for any Eclipse client processes connecting to that machine on port 4075. If
you want to use another port, specify another port number on the startrdodaemon command.

The daemon can also be configured to instantiate the servers on a specified port or range of ports. This is
particularly relevant when you want to only open certain ports through a firewall. To do this, perform this
command with superuser authority:

$COBDIR/remotedev/startrdodaemon [<port> | <low port>-<high port>] 

where:

• <port> is the port number the daemon should use to listen for connections from Eclipse on the client
machine. If no value is given, it will be assigned a default value of 4075. This value matches the value
assigned within the Eclipse installation.

For example,

$COBDIR/remotedev/startrdodaemon 4999

This command will start a daemon listening on port 4999 and will use random server ports.
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• <low port>-<high port> is the range of ports on which the servers (launched by the daemon) should use
to communicate with Eclipse on the client machine.

For example,

$COBDIR/remotedev/startrdodaemon 4080 4090-4999

This command will start a daemon listening on port 4080 and server ports will be in the range 4090 to
4999.

Stopping the Daemon

To stop the daemon, type the following command with superuser authority:

$COBDIR/remotedev/stoprdodaemon <port>

Repairing on UNIX
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_VisualCOBOLDevelopmentHub2.2.sh script in the $COBDIR/bin
directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• This package provides eight licenses for using Micro Focus Development Hub on all platforms.
• If you have purchased licenses for a previous release of this product, those licenses will also

enable you to use this release.
• The latest version of the SafeNet licensing software is required. See the Software Requirements

section in this document for more details.
• Your entitlement for using this product is governed by the Micro Focus End User License

Agreement and by your product order. If you are unsure of what your license entitlement is or if you
wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

Windows

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

UNIX

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).
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• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.

Alternatively, you can install the license file from within the IDE as follows:

1. Start Visual COBOL.
2. Click Help > Micro Focus Product Help > Product LicensingHelp > Micro Focus > Product

Licensing to open the Product Licensing dialog box.
3. Ensure I have a full Visual COBOL license is checked.
4. Click Browse next to the License file field.
5. Select the license file (which has an extension of .mflic), and then click Open.
6. Click AuthorizeFinish to install the license.

You should see a dialog box with a confirmation that the licenses have been installed successfully.

UNIX

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

Windows

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

UNIX

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.
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Windows

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

UNIX

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in Visual COBOL 2.2 Update
1

Visual Studio Support
The following enhancements to COBOL support in the IDE are now available:

Expanded
Copybook View

(Visual Studio 2012 only.) The Expanded Copybook View functionality in the editor was
added in the 2.2 release and this has been enhanced in 2.2 Update 1 so it is now
possible to debug into the expanded copybooks. The functionality includes:

• Stepping inline in the expanded copybook view when debugging - when stepping
into or hitting a breakpoint in the copybook, the copybook automatically expands.
You can disable this feature from the IDE preferences.

• Showing Pinned Data tips inside the expanded copybook.
• Support for QuickWatch and Add Watch inside the expanded copybook.
• Executing some of the debugger commands from the context menu from the

expanded copybook view - for example, Show Next Statement, Run To Cursor
and Set Next Statement.

Some limitations apply.

Call Hierarchy (Visual Studio 2012 only.) Visual COBOL now supports the Visual Studio Call
Hierarchy window for analyzing COBOL PERFORM statements.

Find All
References

The Find All References functionality now works for managed OO COBOL code.

Navigation You can now use Alt+Shift+Up Arrow (or Down Arrow) to navigate the variables in the
editor.

You can use the drop-down types and members to navigate to the different sections
(Linkage section, File section etc.) in your source files.

Project Details
Window

The Project Details Window now includes columns showing the COBOL dialect of
the files and the SQL properties set on them.

Run-Time
Configuration

• You can now use the application configuration file (application.config) in
native COBOL projects to specify some additional settings such as the search
order for called programs, command line handling, or file handling. You can do this
from the new Run-Time Configuration tab.

• When an executable is built using the IDE, the application configuration file is
automatically copied to the output folder and is renamed as <executable-base-
name>.exe.mfgcf.

Samples This release includes the following new samples:

• Airport Demo (managed) - shows how to create a COBOL WCF REST service and
then use a client application to consume it.

• Airport Demo (native) - a basic lookup program that reads the information about
airports from a .dat file and outputs the distance between two airports.
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The Sandcastle sample has been updated and now uses Sandcastle Help File Builder
v1.9.8.0.

Solution
Explorer

(Visual Studio 2012 only.) Support is now available in Solution Explorer for the
following features:

•
Errors and warnings filters - click the arrow next to the (Pending Changes
Filter) icon in the Solution Explorer toolbar, and either click Errors Filter or 
Errors and Warnings Filter to show the files that result in errors or also cause
warnings.

• Searching in Solution Explorer - You can use the search field in Solution Explorer to
search for files in your solution. Searching also finds copybooks in the copybook
dependency view even if they are not part of any of the projects in the solution.

ACUCOBOL-GT Compatibility
The following ACUCOBOL-GT support has been added in this release:

-Di compiler option The -Di compiler option, which initializes Working-Storage data items based in their
type, is now supported.

Btrieve Support
Support for the Btrieve file handling system from Pervasive Software Inc. has been added into Visual
COBOL.

Support is restricted to native COBOL, in a Windows environment.

Compiler Directives
The following compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY-
TYPE

Initializes Working-Storage Section data items to a default value, according to their type.

• Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized
to spaces.

• Numeric items are initialized to zero.
• Pointer items are initialized to null.
• Index items are initialized to the value 1.

Database Access
The following new features have been added as part of database access support:

DB2 ECM

• Support added for DB2 LUW version 10.5
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• Enhanced RETURN-CODE processing

OpenESQL

• Enhanced internationalization support for UNICODE, DBCS and MBCS
• Enhanced GET DIAGNOSTICS statement support
• Enhanced LOB support for CLOB, BLOB and DBCLOB data types
• ADO.NET connection editor now provides context help
• Enhanced IDE support for OPTION directives
• Now provides support for the creation of save points and rolling back to save points

XA Switch Modules

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following new features have been added to XA switch module support:

• New generic two-phase commit module for SQL Server
• Support for DB2 LUW version 10.5
• Support for Oracle version 12.1

Debugging Windows Services
Assigning
memory to
Linkage Section
items

If the debugger steps on a line with an unassigned linkage item (for example, if you
are debugging only a part of your application and no memory has been allocated to
that linkage item), debugging terminates. To assign linkage to that data item and
continue debugging, you need to select the data item, right-click it and click Inspect
COBOL. When prompted, confirm and assign a value to the data item. Alternatively, to
assign linkage, you can right-click the data item in the Variables view and click
Change Value.

Debugging
Windows
Services

It is now possible to debug Windows services. You must be logged on to the console
of the computer running the service and can debug either using just-in-time debugging
and a CBL_DEBUGBREAK call, or using library routines and a "COBOL Wait for
Application Attachment" debug session having added a call to CBL_DEBUGBREAK or
CBL_DEBUG_START to the application.

Indicating that a
file is a
copybook or a
COBOL
program

In COBOL Explorer, you can now use two new file context menu commands to
indicate that a COBOL program is a copybook (Transform Program to Copybook)
and that a copybook is a COBOL program (Transform Copybook to Program). You
may need to use these in situations when you imported existing COBOL source code
in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

Enterprise Server Integration in the IDE
You can now use the context menu for the servers in Server Explorer to enable the display of the
Enterprise Server log information in the Output window (in Visual Studio) or the Console view (in Eclipse).

Fileshare Recovery
Recovery of Fileshare data files has been enhanced.

Rollback recovery is a faster process that aims to fix the files from their failed state.
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This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Micro Focus Heartbleed Update
The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

Interface Mapping Toolkit
You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

Line Numbering for COBOL Programs
This release provides options for auto-inserting or removing line numbers in source files open the editor.
Features include:

• COBOL numbering - line numbers are inserted in the sequence area of the code (columns 1 - 6),
starting at 000100 at the first line, and incrementing by 100.

If it recommended that you use COBOL numbering only if your files are in fixed or variable source
format.

• Standard numbering - line numbers are inserted immediately to the right of area B, in columns 73 - 80,
starting at 00001000 at the first line, and incrementing by 1000.

If it recommended that you use Standard numbering only if your files are in fixed format.

• The Renumber and Unnumber commands available from the context menu in the editor.

Managed COBOL
Visual COBOL now provides support for Java managed means (MBean) in JVM COBOL code that enable
you to manage and monitor RunUnits, and to identify certain issues such as leaks and long-running
RunUnits.

• You can enable an MBean only for a particular RunUnit level or for all RunUnits you create.
• You can view and use MBeans from programs such as Oracle's Java Mission Control or JConsole.
• MBeans include the LogicalRunUnitCount and LiveRunUnitCount attributes that enable a visual

indication of how many RunUnits are live. if the values of these two attributes are different, this might
indicate some issues.

This release includes the following enhancements to the managed COBOL syntax:

Specifying parameters in
the method signature

You can now specify passing parameters and returning items in the method
signature, instead of using a Procedure Division header. This applies to
methods, indexers, iterators, constructors and delegates.

CONSTANT keyword Use the CONSTANT keyword on a field to protect it from being altered.

Operations on string
fields

You can now use the STRING, UNSTRING and INSPECT statements on
fields of type string.
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Tutorials

This release includes the following new tutorials for managed COBOL:

Deploying JVM
COBOL to an
Application Server

Using some ready-made sample projects, this tutorial guides you through
implementing your JVM COBOL code into an Enterprise JavaBean (EJB), then
deploying it to a JBoss application server. Instructions are also included on how
to deploy the application to WebSphere and WebLogic application servers.

Project and Item Templates
Support is now available for using existing projects and files as custom templates to create new projects
and files. You create and configure projects that include the files and settings you would like to use as
templates.

Remote Connections
Visual COBOL now provides a new connection type, Micro Focus DevHub using SSH, that uses a
Secure Shell daemon process to launch a server on the remote host.

You can use this type of connection when the UNIX machine you are connecting to uses LDAP
authentication which is not supported by the DevHub daemon.

Using this connection also means you do not need to run the DevHub daemon process with root privileges.
It also gives you greater flexibility in setting environment variables needed for building or debugging on the
remote server.

Run-time Support
The following new features have been added as part of the run-time support

Run-time Launch Configuration Files

Note: This feature is only supported in a Windows environment.

Use a run-time launch configuration file to ensure an application can be launched when it is deployed in a
separate location to the run-time system (in the case of dynamically bound applications), or when the
licensing daemon is not already running.

Environment Variables

The following environment variable has been added in this release:

strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.

New Terminfo files
The following terminfo files have been added for this release:
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• ansi80x25 - this is based on the old ansi file. A newer version of ansi exists in this release that has no
function key support, which is consistent with ansi terminfo files on various other UNIX platforms. If you
currently use ansi and require function key support, you should instead set the TERM environment
variable to ansi80x25 to continue previous behavior.

• xterm-color and kterm-color - these are now available on all UNIX platforms - previously, they were only
available on Linux.

• aixterm-old (AIX systems only) - this has similar capabilities to the AIX OS terminfo file of the same
name. It differs from the existing aixterm file, because it has no line drawing capability. Line drawing is
only possible with aixterm if it is displayed on an appropriate display (X server).

• vt220-w - this is the wide (132-column) version of the vt220 file, and is based on the vt100-w file. For
more information, see Wide Terminal Mode in the documentation referenced at the bottom of this
section.

There have been a number of additions and fixes to existing terminfo files; refer to the Terminfo Database
and Terminal Devices section of the documentation for full details.

There have also been a number of terminfo files that have been removed; refer to the Backward
Compatibility section for a complete list.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

ASP.NET It is not possible to run ASP.NET Web Sites or Web Services on a production machine
(one that has Micro Focus COBOL Server installed) without an additional setup. This
is because the production machine does not contain development tools such as the
COBOL Compiler. To workaround this, you need to do the following steps:

1. Compile the site prior to deploying it using the Publish Web Site command in
Visual Studio.

2. Edit the .asmx file of the Web service project or the .aspx file of the Web site and
delete the Language="COBOL" statement.

3. Edit the Web.config file with a text editor and delete the line which contains:
<compiler language="COBOL"...

4. Ensure that a .NET Server license is installed using Apptrack.

COBOL
Watchpoints

The debugger ignores a COBOL watchpoint that is hit if there is no statement following
the statement that modifies the data on which that watchpoint is set.

Debugging There is an issue with "Wait for attachment" when you use Visual COBOL for Eclipse
to debug applications that run on some UNIX/Linux platforms. Eclipse connects to the
debugger on the remote machine, but might not attach to the process to debug the
code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Micro Focus Visual
COBOL Development Hub server and for the running process you wish to debug. The
Micro Focus Visual COBOL Development Hub server is the server which you started
either directly with the $COBDIR/remotedev/startrdoserver script or indirectly using the
daemon which is started with the $COBDIR/remotedev/startrdodaemon script.

To check the variable used by the Micro Focus Visual COBOL Development Hub
server:

1. Open Remote Systems view in Eclipse on the Windows machine.
2. Right-click the Shells element of the server connection to be tested and click

Launch Shell.
3. In the Remote Shell view, type echo $TMPDIR in the Command field, and press

Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be
changed in the remote shell and must be set before you start the daemon or
server.

Documentation • A problem in Visual COBOL results in an error when you try to submit the JCL file
as described in the tutorial Getting started with Visual COBOL for Eclipse in the
product help. To work around this, when you follow the steps in the topic Importing
the BankDemo project and adding the source files, execute the step Setting
Compiler directives before executing the step Specifying the copybook paths for the
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project. This ensures the BankDemo projects is rebuilt. The instructions have been
updated in the Micro Focus Infocenter version of the help.

• In Visual Studio 2012, clicking Help > Micro Focus Product Help > Product
Documentation results in the message "Cannot find requested topic on your
computer". If you see this message, click Micro Focus Visual COBOL 2.2 for Visual
Studio 2012 in the Contents tab to display the documentation as expected.

• If you install Visual COBOL for Visual Studio 2012 and its documentation is not
available in the Microsoft Help Viewer, perform the following steps:

1. In Visual Studio 2012, click Help > Add and Remove Help Content.
2. Choose the Manage Content tab.
3. Check the Disk radio button, then navigate to the folder containing the Visual

COBOL for Visual Studio 2012 documentation. By default, this is C:\Program
Files (x86)\Micro Focus\<product name>\help.

4. Select helpcontentsetup.msha and click Open.
5. In the content list, click Add next to the Visual COBOL entry.
6. Click Update.
7. Click Yes on the User Account Control and Microsoft Help Viewer 2.0 dialog

boxes to enable the update to continue.

The documentation for Visual COBOL for Visual Studio 2012 is added to the
Microsoft Help Viewer.

Note:

This problem only occurs if you install Visual COBOL for Visual Studio 2012
while documentation for Visual Studio 2012 is being downloaded or updated,
which typically happens when you install Visual Studio 2012 or run it for the
first time.

• A known issue in JRE 1.7.0_45 (issue JDK-8028111) causes problems with
searching and indexing the help in the Eclipse help viewer if you are running
Eclipse on a machine that has this version of JRE installed.

Database
Access

If you have a remote COBOL project under Eclipse that uses DB2 ECM in Visual
COBOL or HCO for DB2 LUW in Enterprise Developer and the DB2 software is not
installed on the client machine where you are using the Eclipse IDE, you receive
background parsing errors in your application. To resolve the issue, you can do either
one of the following:

• Disable background parsing Window > Preferences > Micro Focus > COBOL >
Editor and disabling the checkbox for Background parsing.

• Install the IBM DB2 client-side software on the machine on which you are running
Eclipse. Go to the IBM Support Home and locate the page entitled "IBM Download
Fix Packs for IBM Data Server Client Packages" .

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

Expanded
Copybook View
(in Visual
Studio 2012)

• When you add a COPY statement in a COBOL program and then show it in
Expanded Copybook View, the line for the copybook statement is read-only. If you
then perform an Undo in the COBOL program, the COPY statement is removed
while the contents of the copybook is still shown in the program.

• Replace All does not work inside the Expanded Copybook View
• For copybooks with file extensions that are not traditionally associated with COBOL

you must first add the file extension to the list of known copybooks extensions in
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Tools > Options > Text Editor > File Extensions before you can show them in
Expanded Copybook View.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the
previous version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is
to avoid some problems that might result in files not being installed. This is required
only on Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import
on the Enterprise Server Administration home page.

• When installing this product for Visual Studio 2010, if you already have Visual
Studio 2010 Isolated Shell with Service Pack 1 (SP1) installed, you might
experience problems with starting Visual Studio after the installation. This is a
Microsoft issue relating to the Integrated Shell (installed as part of the Micro Focus
product installer) overwriting some Visual Studio SP1 components. To resolve the
issue you need to repair Visual Studio 2010 SP1.

• On UNIX, check UNIX Installer Issues before you start the installation.

Native COBOL On Windows XP, when building a native COBOL application in Visual Studio, a dialog
may pop up with error "Unhandled exception at 0xc0006866 in cobol.exe:
0xC0000005: Access violation reading location 0xc0006866)". This is caused by
Symantec antivirus runtime protection. To resolve this, you need to apply the following
fix from Symantec: http://www.symantec.com/business/support/index?
page=content&id=TECH97280&locale=en_US.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic
may fail with a ClassCastException. To work around this issue, you need to deploy
mfcobol-xa.rar first, then need to undeploy this file and deploy the local one,
mfcobol-localtx.rar. If there are issues deploying using the WebLogic GUI, you
can use the command line. If there are issues with this as well, try reducing the length
of the command (for example, by moving the file to a location with a shorter path).

Visual Studio
IDE

• In the properties of a managed project, the Application page currently allows you
to select any of the static methods in the application as a Startup object. This is
incorrect. You should always set only the first static method or the program name
as a Startup object in order for the project to build.

• Using Call Hierarchy locks the source files currently opened in the editor. To work
around this problem, you need to trigger a syntax check - for example, by making a
small change to one of the open files.
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• SQL: COBSQL

.NET Compiler

Back to the list

• In member reference in managed COBOL syntax, you may now only use parentheses when referencing
methods. You can no longer specify parentheses when referencing fields or properties, as this will
produce a syntax error. For example:

set intLength to testString::Length()

must change to:

set intLength to testString::Length

SQL: COBSQL

Back to the list

• COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• .NET ESQL Support
• .NET RTS
• Adis
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Resource Manager Interface
• CAS Security
• CAS XA Switch modules
• CASRDO
• Compiler
• Compiler ECM Support
• Cobdebug
• Documentation
• Eclipse - Debug
• Eclipse IDE
• Eclipse IMTK
• ES Monitor/Control (ESMAC)
• File Handling - External File Handler
• File Handling - Fileshare
• HCO for Microsoft SQL Server
• JVM - Compiler
• JVM - RTS
• LE370 Support
• MDSA API for CAS
• MF Communications Server
• MF Directory Server
• MF Server Administrator (GUI)
• MFIO
• Micro Focus Heartbleed Update
• NCG
• Run-Time System
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• UNIX Cob
• Visual Studio IDE
• Web Service Client
• XDB Server
• XDB: Problems not classed above
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• XML Syntax Support Preprocessor
• XML Syntax Support Runtime

.NET Compiler

Back to the list

• When compiling for managed code with the RM(ANSI) directive, the EXIT PROGRAM statement now
works as expected. Previously, it was causing all files open in the program to be closed, which should
only occur if the RM directive (without the ANSI parameter) is specified.

2690872 (1093437)
• (As 1091900) Previously, when the NOBOUND directive was set, generation of a level 88 condition

name on a subscripted item could result in a system error.

2685375 (1093076)
• An INITIALIZE statement without the REPLACING phrase now initializes PIC N data items to DBCS

spaces (x"8140"). In a previous version, this was incorrectly initializing to ASCII spaces (x"20").

2682846 (1092779)
• An INITIALIZE statement applied to a particular element of a subscripted group, where a space fill

should precede a sub-occurs item, now applies the space filling to the correct element of the
subscripted group.

2682845 (1092778)
• A problem has been fixed where an INITIALIZE statement referencing a group that redefines something

did not function correctly if the group itself was not otherwise referenced.

2681790 (1092700)
• Arithmetic statements involving subscripted operands no longer cause bad code generation. Previously,

this was likely to happen when the subscripted data item was declared at 01 level, or was declared
within a group, which itself was never referenced.

2677890 (1092368)
• In previous product versions, the event which was the target of an attach or detach statement could not

be specified as the end of a member reference chain. This meant that it was not possible to have
statements like:

attach method self::MyMethod to self::TextBox::TextChanged

This is now fixed.

2676123 (1092130)
• Property initializers as part of the 'new' (constructor) expression are now functioning correctly.

2674668 (1091974)
• Previously, when the NOBOUND directive was set, generation of a level 88 condition name on a

subscripted item could result in a system error.

2673571 (1091900)
• Previously, a mixture of static and instance files within a class could result in bad code generation. This

has now been resolved.

2672322 (1091732)
• Previously, in situations where a reference-modified move from a pic x to a pic n field has the same

length expression on each side, compiling produced incorrect code which resulted in the target being
truncated.

2670726 (1091595)
• Type inference for generic methods is now working as expected. Previously, in certain cases, it was

causing 'COBCH0829 Could not find method...' errors.

2670658 (1091643)
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• Programs compiled to managed code, and which use the SSRANGE directive, no longer produce
system errors at compile time.

2668437 (1091389)
• After stepping into an INVOKE or a PERFORM statement, the call stack will now point to the INVOKE or

PERFORM itself, and not to the statement following it.

(583690)
• When compiling for .NET, XML comments that are attached to types and members (for example,

methods and fields) now generate warnings if the XML text is not correctly formatted.

(595368)
• Previous versions of the product allowed the caller of a method, in which the last parameter was an

array, to specify a list of zero or more arguments of the array element type, in place of a single array
argument. By default, this behavior is now only supported when the array parameter in the target
method has the PARAMS attribute. To restore the old behavior, the new ILPARAMS directive has been
introduced.

(599666)
• Previously, the resolution of shortened type names (those without explicit namespace) could fail when

different programs had different ILUSING lists. This could occur when there were multiple programs in a
project and one or more of them had $set statements with the ILUSING directive.

(599903)
• A problem where generic classes would wrongly appear to have errors on background parse has been

resolved.

(601182)

.NET ESQL Support

Back to the list

• OpenESQL did not correctly handle EXEC ADO BIND CONNECTION statements that passed the
connection name in a host variable.

2681358 (1092636)
• Previously, the OpenESQL precompiler split DBCS SQL statements which resulted in receiving a

managed OpenESQL run-time error when processing the statements.

2672260 (1091722)
• The LIKE operator was not invoked properly for .NET DATAROWS cursor search conditions.

2671820 (1091683)
• Some consistency issues with sensitive cursors have been resolved in the ODBC, JDBC and ADO run-

time systems for OpenESQL.

2667592 (1091300)

.NET RTS

Back to the list

• An error when converting values from type decimal to other COBOL data types has been fixed.

2695116 (1093886)

Adis

Back to the list

• REVERSE-VIDEO now works as expected when using the X"AF" function.

2683509 (1092851)
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• MS ACCEPT statements now sound a beep when invalid characters are entered into integer or decimal
fields. Integer fields no longer accept invalid characters and normalise.

2680081 (1092542)
• MS ACCEPT statements now display numerics with space fill and sign leading so that integers and

decimals are appropriately aligned.

2680081 (1092543)
• The attributes specified in the screen section are now displayed correctly after a call to the X"AF"

function 81 has been made.

2650012 (1089634)

CAS (COBOL App Server) General

Back to the list

• Multiple casout calls (using the -r option) in a single process now work correctly.

2694290 (1093800)
• When accessing TS/TD on error, the file status is now displayed correctly.

2684719 (1093023)
• HSF records no longer contain incorrect dates when a task runs past midnight at the end of a month.

2644616 (1089363)
• Messages issued from casstop are now sent to stdout.

2643162 (1089019)
• All system abend messages are now reported to the console.

(602933)

CAS Admin Console

Back to the list

• The JES Program Path and CICS Transaction Path now accept paths of up to 4096 characters.

2665324 (1091104)

CAS Resource Manager Interface

Back to the list

• A thread synchronisation issue was causing responses to be lost intermittently. For stateful requests,
this could result in lost SEPs (whereby a SEP would appear as busy even though it was not processing
any work).

2686429 (1093442)

CAS Security

Back to the list

• A new user objectclass instance added to an LDAP-based external security manager now has its initial
login attempts count value set correctly.

2637659 (1088656)

CAS XA Switch modules

Back to the list
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• A new SQL Server XA switch module provides support for xa_recover and also handles implicit rollback
by SQL Server more cleanly than previous switch modules.

2679162 (1092481)

CASRDO

Back to the list

• Clicking Resources > JES > Catalog in ESMAC now opens the initial screen without showing the
results of any previous searches.

2656391 (1090454)

Compiler

Back to the list

• LOCAL-STORAGE data in nested programs now behaves as expected and as it does on the mainframe
- as LOCAL-STORAGE of the main program.

2693843 (1093746)
• A MOVE from a group item to a DBCS target that requires padding now behaves as expected.

2692634 (1093553)
• DELETE statements that contain the END-DELETE scope terminator now compile as expected.

2690465 (1093235)
• UNSTRING on LINKAGE SECTION data items with reference modification could sometimes give the

wrong result.

2684812 (1092998)
• Using large EXEC SQL statements no longer causes the Compiler to hang.

2684713 (1092993)
• The ? NUMERO SIGN (U+2116) Shift-Jis FA59/8782 is now converted correctly to EBCDIC value 446e

under CHARSET(EBCDIC).

2683297 (1092823)
• MOVE figurative constant to PIC G item under CHARSET(EBCDIC) now returns the expected results.

2683091 (1092801)
• A MOVE CORRESPONDING statement with a GLOBAL subscripted target now compiles as expected.

2682557 (1092981)
• A program compiled with the FDCLEAR Compiler directive and containing a numeric file record now

compiles as expected.

2678050 (1092326)
• The asterisk character is now treated correctly in COPY REPLACING text under mainframe emulation.

2676006 (1092571)
• A literal greater than 80 bytes but less than 160 bytes in length and containing non-ASCII characters will

now compile as expected with a mainframe dialect.

2670083 (1091560)
• Programs that contain EXEC INCLUDE statements inserted by a preprocessor now debug as expected.

2661838 (1091416)
• ISO2002 and SNI table VALUE syntax is now working as expected for multi-dimensional tables that are

not directly nested within each other.

2651916 (1089808)
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• The Compiler error message 62 (COBCH0062) has been clarified by changing "Nested COPY
replacement not supported" to "Nested COPY replacement causes termination of parent COPY
replacement".

(599823)
• The SQL TYPE DBCLOB(n) now creates the correct COBOL record structure.

(599679)

Compiler ECM Support

Back to the list

• The SQL(CHECK) option no longer incorrectly affects the setting of the unrelated NCG option 'CHECK'.

2685791 (1093351)

Cobdebug

Back to the list

• When stepping through a program that has a watchpoint set in it, all statements are now being stepped
correctly.

2664045 (1091500)

Documentation

Back to the list

• You may now specify an SSL-enabled listener when submitting jobs via CASSUB. You achieve this by
using the tcpssl protocol on the /s or -s switch.

2671020 (1091619)
• The Important note about User Access Controls in the IMTK Tutorial now clarifies that this applies to

Windows users only.
• A compiler directive INIT-BY-TYPE has been provided to allow initialization of each data type to a

sensible value for that type.

2650462 (1091658)
• The INITIALIZE verb now supports multiple categories in a single REPLACING clause.
• Variable length record files that are 4 bytes or smaller are padded to 8 bytes.

2537147 (1081777)

Eclipse - Debug

Back to the list

• The Enterprise Server Dynamic Debugging facility, cobesdebug, is now supplied with this product to
enable character mode debugging of transactions and services running on a local enterprise server on
UNIX and Linux. See your product documentation for information about how to use the facility.

2685218 (1093046)
• Stepping through a program with copybook files that contain a single line now highlights the COPY

statement correctly.

2674776 (1092000)

Eclipse IDE

Back to the list
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• When creating NFS or RSE remote projects, you can now use a new type of remote connection, Micro
Focus DevHub using SSH. It uses the standard SSH daemon and a UNIX command to launch the
DevHub server and does not require the DevHub daemon to be running.

2681305 (1092717)
• When there is a breakpoint set on a copybook in Copy View, during debugging the execution only stops

once for this instance of the copybook.

2675063 (1092946)
• Build projects that contain a large amount of folders no longer causes the IDE to freeze.

2674982 (1092179)
• It is now possible to debug Windows services using the Eclipse IDE. You must use a command prompt

of the computer running the service.

2674623 (1092008)
• When debugging Enterprise Server applications that use remote projects, you can now add remote file

system directories to the Debug Symbols lookup path.

2653012 (1092794)
• When debugging a program running on a remote machine, you could receive errors if stepping quickly

through the program.

2651982 (1090920)
• Eclipse no longer crashes when importing new programs into a COBOL project or when using the

"Determine Directives" menu item.
• An issue with importing Net Express projects that built ocx targets has been resolved.
• In COBOL Explorer, you can now use two new file context menu commands to indicate that a COBOL

program is a copybook (Transform Program to Copybook) and that a copybook is a COBOL program
(Transform Copybook to Program). You may need to use these in situations when you imported existing
COBOL source code in the Eclipse IDE and some of the files were incorrectly identified as either a
copybook or a COBOL program.

• A problem that prevented locating resource files within linked resource directories has been resolved.
• The underlying version of Remote System Explorer has been updated from 3.3 to 3.5 to resolve issues

with Japanese locales and messages in remote projects.
• If the debugger steps on a line with an unassigned linkage item (for example, if you are debugging only

a part of your application and no memory has been allocated to that linkage item), debugging
terminates. To assign linkage to that data item and continue debugging, right-click the data item, and
click Inspect COBOL. When prompted, confirm and assign a value to the data item. Alternatively, to
assign linkage, you can right-click the data item in the Variables view and select "Change Value".

• Opening revisions of a COBOL file from a Source Control System plugin in Eclipse is now supported for
CVS, SVN or other SCM plugins. It is now possible to open revisions of COBOL files from the COBOL
search view, the CSI search view, the Find Reverence view. Navigation between the Outline view and
the editor and using the "Locate definition" (F3) command is also supported.

• The Generate Client from WSDL feature is now documented.

Eclipse IMTK

Back to the list

• You can now use the Interface Mapping Toolkit to create Web Services and Java Interfaces for remote
COBOL projects.

ES Monitor/Control (ESMAC)

Back to the list

• In the ESMAC (casrdo45) page, there is now provision to filter and list the members of a particular PDS.
The filter text is PDSNAME(*). The PDSNAME should be the complete name of the PDS, and cannot
contain any wildcards.
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2500753 (1078391)

File Handling - External File Handler

Back to the list

• When using the RMFM File Handler, a file status '05' is returned when executing a DELETE FILE
statement, if appropriate. This emulates the behavior of the RM/COBOL run-time.

2685220 (1093089)
• A rollback recovery of a REWRITE where the record size was being reduced was producing incorrect

results.

2685069 (1093085)
• When a DD name is associated with several concatenated data sets of different charsets, the returned

data has the charset encoding of the first data set. However, if the first data set is LSEQ, the returned
data has the charset encoding of the application program.

2677941 (1092434)
• cobfhrepro2 now produces the correct output for FCD2.

2664465 (1090972)
• A new environment variable, STRICTVSAM, has been introduced. When it is set to ON and under a

mainframe emulation, a file status of 37 is returned when you open an existing VSAM file for OUTPUT
and the file has or previously had some data written to it, or if the file format is different from the file on
disk. The default for this variable is OFF.

2660766 (1090639)
• When reading concatenated datasets, each dataset in concatenation must use the same RECFM,

either all FB or all VB.

2654517 (1091793)
• The FOLDER section in a file handler configuration file now supports relative paths.

2653787 (1090290)
• Btrieve files are now supported, using the xfh2btr call conversion module, for native COBOL, running in

a Windows environment.

2598434 (1086466)
• 64-bit fileshare clients would fail to connect if any cci configurations settings were used.

File Handling - Fileshare

Back to the list

• The Escape character was not being honoured for filenames passed to FSVIEW which caused
filenames containing $ to be interpreted as environment variables.

2660207 (1093021)
• MFJSORT now correctly displays the file status of a queried VSAM file, rather than a generic error

message, when the file being queried returns a non-zero file status.

2589273 (1092107)

HCO for Microsoft SQL Server

Back to the list

• The NOSTMTCACHE SQL compiler directive option is invalid and no longer available when setting SQL
Preprocessor options from the IDE.

2694876 (1093861)
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• OpenESQL returned an error when a FETCH had more output host variables than the number of
available result columns; OpenESQL now ignores excess columns, resulting in improved compatibility
with DB2.

2694548 (1093840)
• Previously, a problem occurred with DB2 YEAR() function when taking date duration or timestamp

duration as argument with the directive SQL(DIALECT=MAINFRAME).

2683713 (1092874)
• Using FETCH OR SELECT INTO statements that have more output host variables than the number of

columns in the result no longer results in errors.

2676276 (1092708)
• The SPD generator did not honor the EXTERNAL NAME option correctly during the generation of the

stored procedure wrapper.

2659338 (1090674)
• HCOSS now emulates mainframe SET CURRENT SQLID and SET CURRENT SCHEMA statements.

2507765 (1078735)

JVM - Compiler

Back to the list

• The statement ACCEPT operand FROM DATE-ISO4 now works correctly in .NET and JVM COBOL.

2681556 (1092861)
• When compiling for JVM COBOL, COMPUTE statements within a large perform range, where the

arithmetic expression involves division by a power of 10 now produces the expected results.

2680641 (1092792)
• A new Compiler directive has been introduced to control how a method that has an array as its last

parameter can be called. When ILPARAMS is set (which is the default), you can call the method using a
list of items of the same array element type, instead of specifying a single array. When ILPARAMS is not
set, you can only specify a list of items if the target method has the PARAMS attribute. Previous
compiler versions allowed the use of a list even when the method did not have the PARAMS attribute,
which is equivalent to the current default behavior.

JVM - RTS

Back to the list

• Fixed an error in arithmetic statements in JVM COBOL where the target is a comp-2 item.

2691797 (1093424)

LE370 Support

Back to the list

• LE370 parameters that continue on the next line are no longer flagged.

2681691 (1092669)
• TSO ALLOCATE command emulation now supports the use of "F B".

2668742 (1091453)
• An unsupported LE option in the code no longer invalidates the options that follow.

2668740 (1091425)
• A fault that caused the data received by an EBCDIC program when a 'READ from SYSIN' was

performed to be in ASCII format has been corrected.

2657391 (1090401)
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• CEE3PRM now successfully retrieves the parm value to the calling program.

2654879 (1090140)

MDSA API for CAS

Back to the list

• If an enterprise server instance is started by an Enterprise Server user account that has execute
privilege but not update privilege for that server, you now receive an INSUFFICIENT_ACCESS error
when the server starts.

2664445 (1091238)

MF Communications Server

Back to the list

• When using casout to get job information, sometimes you could receive an error and the output was
trucated.

2693283 (1093638)
• An issue where terminating 3270 sessions would result in high CPU usage in the MFCS process has

been fixed.

2682179 (1092886)
• The mfpackage utility for removing deployed services from Enterprise Server is now included with Micro

Focus Visual COBOL Development Hub.

2675212 (1092127)
• In version 2.2 of this product, the received data was missing from the trace messages for CTG and ISC

conversations. This has now been fixed.

2674286 (1091971)
• Some of the Enterprise Server functions for informing running enterprise server of security updates and

for retrieving the list of printers available on the server system were broken in Enterprise Developer 2.2.
This has now been fixed.

(601260)
• You no longer receive exceptions in MFCS when the data-trace option is enabled for a CTG listener.

(601465)

MF Directory Server

Back to the list

• When using the export and import functionality of the MFDS XML Enterprise Server configuration, XRM
name and label definitions are now exported and imported correctly.

2683510 (1092852)
• When using the export and import functionality of the MFDS XML Enterprise Server configuration, the

open and close string properties of XRM resources now support the inclusion of double quotes.

2682635 (1092777)
• On Solaris SPARC, the value of the Enterprise Server Administration GUI journal size option was being

incorrectly set to zero.

2681195 (1092638)
• When adding or editing an IMS MPR definition in the Enterprise Server Administration GUI, you can

now use comma as a separator in the class field to enter multiple class definitions.

2676449 (1092164)
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• The mfds export and import command line options -x and -g XML now also support exporting and
importing enterprise server script configuration information.

2668554 (1091412)
• XML import in the MFDS no longer fails if the XML source code contains long paths.

2668553 (1091409)
• When using the Enterprise Server Administration to edit the properties of JES Initiators, JES Printers,

IMS MPRs and XRMs, the GUI now rejects duplicate names.

2668020 (1091336)
• Session cookies in the browsers for the Enterprise Server Administration GUI now use the HttpOnly flag

for additional security.

2666975 (1091258)
• The browser auto-complete feature is now disabled for the password fields in the Enterprise Server

Administration GUI.

2666975 (1091260)
• If the Enterprise Server Administration HTML GUI is in "restricted access" state, a logged on user now

needs to have "administer user" levels permission to see the "Display" options in the LHS of the GUI.
This includes the "Directories", "Statistics", "Sessions" and "Journal" menu options. The "administer
user" option is available by default to any member of the #DSAdmin MFDS user group. In MLDAP ESM
security, this permission is defined by Update, Add or Delete ACE permissions against the "User
Administration" resource in the "Enterprise Server Administration" resource class under "Enterprise
Server Resources".

2663991 (1090934)
• When exporting the Enterprise Server configuration in XML format with the "mfds -x" command line

option, the MSS ISC and CTG listener information was not formatted correctly, which resulted in an
incorrect behavior when you reimported the XML configuration.

2651735 (1090147)
• When you use the Enterprise Server Administration HTML GUI to create a user group, the following

characters are no longer allowed in name: '< >', ';', '"' and '&'.

MF Server Administrator (GUI)

Back to the list

• When trying to change a password from the Enterprise Server Administration HTML logon page,
additional checks are made before reporting the success or failure of the request.

2659582 (1090525)
• The execution scripts configured for an enterprise server instance can now use the credentials specified

on the Start\Stop page of the server in Enterprise Server Administration. For example, to use the
specified credentials to start an enterprise server instance, you need a script with the following
command:

• On Windows:

casstart /r%ES_SERVER% /u%TXUOPERATOR% /p%TXPOPERATOR%

• On UNIX:

$ES_SERVER, $TXUOPERATOR

Where:

• TXUOPERATOR resolves to the user id.
• TXPOPERATOR resolves to the password.

After the enterprise server instance uses these environment variables, they are reset to blank and are
no longer available to query.
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2599100 (1086661)

MFIO

Back to the list

• MFGENER now works with the server using FCD3 protocol.

2676130 (1092134)
• The comments in the MFAVTAM sample member have been updated.

2674286 (1091976)
• SM2 no longer segfaults when a member has been deleted on the mainframe.

Micro Focus Heartbleed Update

Back to the list

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

NCG

Back to the list

• An error could occur at generate time for programs with calls to INTRINSIC functions that had multiple
ALL subscript parameters.

2695026 (1093885)
• An issue in cob which caused a core dump when all entry points in the main program were invalid has

been fixed.

2663974 (1090927)
• An issue has been resolved where the debugger would not step into the code when a PERFORM

statement is the last statement in a WHEN branch of an EVALUATE statement.

Run-Time System

Back to the list

• When a container end event is received, all external files that are open in the container now close
correctly.

2513669 (1079282)

Setup Issues (UNIX)

Back to the list

• A problem with the installer where it was not performing a check for whether libstdc++ is installed has
been fixed. You no longer receive an error "CASCD0144S SEP 00002 for ES ESDEMO exited with
value 00127" when trying to start 32-bit enterprise servers.

2672995 (1092055)

SQL: COBSQL

Back to the list

• COBSQL Pro*COBOL error messages displayed only up to 80 characters.

2681983 (1092788)
• Previously, commented-out END-EXEC statements were causing a Compiler error. COBSQL now

ignores such statements.
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2680341 (1092533)
• The COBSQL precompiler was updated so it does not attempt conversion of source lines containing the

continuation character.

2663986 (1090930)

SQL: DB2 ECM

Back to the list

• When a CREATE TABLE statement contained a PARTITION parameter, the HCO DDL processor
sometimes generated invalid DDL.

2682214 (1092725)
• A new option (SAVEDDL) is available in the HCO DDL processor. With this option set, any DDL

converted from the input DDL file is saved and not executed. The DDL processor now supports
specifying the IN <tablespace> and COMPRESS <option> parameters but not modifying them.

2673448 (1091907)
• Previously, the HCO IMPORT tool could go into a loop if the LOB column was in the import data set.

2673443 (1091887)
• When compiling on a 64-bit systems, the DB2 pre-compiler incorrectly generated an error "DB0121

Package name is too long."

2673259 (1091920)
• The HCO DDL processor now accepts column names greater than 18 characters. Previously, in this

situation, you received SQLCODE error -205 when the DDL was processed.

2673085 (1091829)
• The HCO IMPORT tool now supports a new parameter (SAVEDEL) which enables converting DSN

import files to delimited format. When used with this paramter, the HCO IMPORT tool only converts the
file and does not perform an actual import.

2672865 (1091891)
• The HCO Import Data tool was not checking for invalid lengths passed for VARCHAR column data; the

tool now checks this and when an invalid length is passed, issues an error message identifying the
affected column.

2661781 (1091056)

SQL: HCO for SQL Server

Back to the list

• HCOSS now handles statements of type "SET hostVariable = CURRENT SQLID" correctly.

2693537 (1093690)
• The HCOSS Assess Application Migration tool flagged CALL statements as errors without checking

parameter directions. These CALL statements are now flagged as 'in doubt' to initiate an assessment of
parameter directions.

2685247 (1093156)
• The OpenESQL preprocessor and runtime now support AMODE(31) address pointers and swapping

COMP fields in SQLDA for user-defined mainframe style SQLDAs.

2684229 (1092978)
• COBOL stored procedures could not perform database updates when called from a SQL Server trigger.

2680257 (1092809)
• OpenESQL and HCOSS now correctly compile statements that contain CASE expressions.

2679336 (1092605)

58 | Resolved Issues



• OpenESQL now supports a generic syntax for setting and rolling back to transaction save points that
work with Oracle, DB2, and SQL Server.

2676145 (1092138)
• Although mainframe DB2 supports FETCH INSENSITIVE from SENSITIVE STATIC cursors, which has

a SQL Server equivalent KEYSET cursor, SQL Server does not support FETCH INSENSITIVE from
KEYSET cursor. This is a permanent limitation.

2676140 (1092137)
• OpenESQL did not support BLOB, CLOB, and DBCLOB host variables larger than 64K.

2649752 (1089622)

SQL: OpenESQL

Back to the list

• OpenESQL did not support using the DB2 VALUES INTO statement with DB2 LUW.

2694069 (1093906)
• The OpenESQL preprocessor incorrectly rejected host variable character definitions that contained

x'091' characters.

2692065 (1093465)
• You can now specify SQL(NOCHECKSINGLETON) in applications that require compatibility with older

products to check for unfetched rows after a singleton SELECT. In such cases, the returned SQLCODE
value is zero rather than an error or a warning.

2691736 (1093420)
• The SQL(TSTAMPSEP)compiler directive could not be explicitly set to a space character, for example

SQL(TSTAMPSEP= ). This is now the default setting unless overridden by specifying
SQL(DIALECT=MAINFRAME).

2691212 (1093364)
• In the IDE, the TSTAMPSEP directive was not listed as an OpenESQL compiler directive option.

2685702 (1093116)
• When SQL(NODETECTDATE) is set after SQL(DIALECT=MAINFRAME), HCOSS does not attempt to

convert date, time or timestamp literals in static or dynamic SQL statements.

2685422 (1093615)
• DB2 LUW applications could not use DECLARE GLOBAL TEMPORARY TABLE statements that were

not syntactically valid for DB2 z/OS.

2685219 (1093346)
• The sqlda.cpy copybook could not be compiled using the ENTCOBOL mainframe dialect.

2682522 (1092825)
• A new XA switch module is now available that supports XA recovery.

2680297 (1092528)
• Previously, you would receive error COBCH002 when SQL(NOPRE) was specified because the ODBC

precompiler would try to generate code using a variable which was not defined.

2679267 (1092438)
• The OpenESQL pre-compiler generated code that swap COMP host variables incorrectly if the SQL

statement got an SQL runtime error.

2677606 (1093013)
• The OpenESQL precompiler sometimes incorrectly generated swap code for COMP host variables if

they were used for both input and output in same SQL statement which resulted in SQLCODE of +100
being returned.

2675122 (1092454)
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• A problem with SQL(CHECK) no longer occurrs when using binary host variables.

2673281 (1091832)
• A problem with nested select queries in ESQL 'select into' statements has been fixed.

2672519 (1091768)
• Previously, an incorrect code was generated for an INSERT statement that used an indicator variable

array when DBMAN=ADO was set.

2671938 (1091715)
• The support for EXEC SQL GET DIAGNOSTICS has been extended to include DB2_ROW_NUMBER,

ROW_NUMBER and COLUMN_NUMBER as diagnostic items that can be retrieved by an application.

2670955 (1091611)
• The OpenESQL preprocessor could sometimes improperly decode DBCS host variable characters

which resulted in receiving an "ES0109 Invalid data name" message.

2670725 (1091594)
• The OpenESQL pre-compiler incorrectly changed the underscore character (_) to a dash character (-) in

an EXEC SQL WHENEVER statement.

2670723 (1091593)
• Dynamic SQL statements were not releasing JDBC cursors.

2670548 (1091585)
• OpenESQL for JVM COBOL prevented type byte[] host variables from being used.

2667023 (1091240)
• The SQL Directives information available within the Visual Studio and Eclipse IDEs contained an error

regarding the available options for the XDB(DATE) and XDB(TIME) directives.

2666213 (1091185)
• Some issues relating to the use of PIC G /PIC N DISPLAY-1 and some DBCS host variables have been

resolved.
• When using Data Direct ODBC drivers, PIC N NATIONAL host variables always uses UTF-16 instead of

UTF-8 which previously happened on some platforms.
• Some problems with using Data Direct's ODBC driver for Microsoft SQL Server have been fixed.

UNIX Cob

Back to the list

• Cob now checks for duplicate symbols defined in objects that are passed to cob for linking.

2651626 (1089779)
• Previously, ccbl was leaving behind a file named cobxi* in the $TMPDIR or /var/tmp directories.

Visual Studio IDE

Back to the list

• When using a continuous integration system (such as Team Foundation Server), it was not possible to
build any COBOL project unless the user account under which the builds were executed had been used
to start Visual Studio at least once.

2690873 (1093514)
• When you use the Create Project From Existing Code Files wizard to create COBOL projects, it now

sets the output name or the assembly name to match the name of the project and also selects the
correct build configuration.

2684455 (1092962)
• When adding a file as a link to a virtual folder of a project when virtual view is switched on, the IDE no

longer creates a physical folder when you switch off the virtual view in Solution Explorer.
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2676171 (1092151)
• Opening the project properties for a Managed Procedural Multi-Output project from the context menu

now works correctly.

2672907 (1091794)
• Creating a COBOL project in a directory containing DBCS characters could result in build errors.

2664439 (1090964)
• Executables can now use run-time tunables without you having to set the COBCONFIG.BLOCK

environment variable provided that the Application Configuration file for the executable is located in the
same folder as the executable and is named <executable-base-name>.exe.mfgcf.

2644263 (1089150)
• You now receive Compiler output when you are using MSBuild from the command line to build projects,

when the verbosity level is set to Minimum.

2617055 (1091210)
• Managed COBOL programs that use RM/COBOL data file support now work correctly when you debug

or run them from within Visual Studio.

2609061 (1087614)
• An issue where changing the project properties would not trigger a background parse has been

resolved.
• In a managed COBOL project in which some of the programs contained errors, if you opened a program

that did not contain errors, it was sometimes marked as containing errors in Solution Explorer. If you
subsequently opened the program containing errors and fixed them, the errors would not be removed
from the Error List or from Solution Explorer.

• If you specified that a virtual folder should include file extensions that matched the extensions of items
in the project, those items did not move to the virtual folder immediately.

• Previously, copybooks on sequential lines expanded inline in the source code were incorrectly colored
as read-only though you could still edit the expanded code as expected.

• When you specified project location and project type in the Create New Project From Existing Code
File wizard, if you added subfolders on the same page, the Next button would not be enabled.

• When converting Net Express projects to Visual Studio solutions, the conversion no longer creates a
project named "<SolutionName> Shared".

• Sometimes, it was not possible to type anything in a copybook expanded inline at the start of the line
immediately following the end of the copybook.

• The column position for items in columns 128-256 appeared negative.
• When Virtual View was enabled, adding a form, a WPF object or a settings file to a .NET project

resulted in an error.
• Deleting a virtual folder that contained other virtual folders could cause the IDE to hang.
• If you moved, renamed or deleted a virtual folder, turned off the Virtual Folder view and then turned it

back on, files would sometimes move to other virtual folders or disappear from Solution Explorer.
• For native COBOL projects that contain dependencies on library files or objects that are not part of the

project, if one of those dependencies is updated and you rebuild the project, the project will be relinked
using those updated files.

• If you used the REPLACE statement in a program, the Show All Copybooks command would have no
effect for that program.

• The default debugging options for Native COBOL in Tools > Options > Debugging > COBOL are now
correctly enabled.

• It was not possible to navigate to an item in another file, where the item was on a line number greater
than the number of lines in the current file.

• The Add Existing Item dialog now includes a filter which enables you to add files of several supported
types at the same time.

• When navigating to an error on a source line that contains tabs, the highlighted code sometimes did not
match the error.
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• The Virtual View in Solution Explorer now provides a default virtual folder for service interfaces. The
folder does not show though for existing projects in which you have added your own virtual folders.

• Previously, it was not possible to debug a project using "Start Project" if the output name of the project
was specified on the "COBOL Link" tab in the project's properties.

• The Add Existing Item dialog now displays all supported COBOL file extensions, including any new
ones that you have added to the IDE options. If you configure the IDE options to add or remove file
extensions from the list of extensions for COBOL source files, you must restart the IDE before the
change to take effect.

• If an error or warning is detected in a copybook, the icon for the program containing the error will now
be updated to reflect this.

• The COBOL Source virtual folder now only contains files which can be compiled (which have their Build
Action set to Compile in the file properties). Files which were previously in this virtual folder but do not
compile will now appear in the Copybooks virtual folder or in the project root. .

• Copying block selections of code and pasting them in an expanded copy view no longer replaces the
selected lines of code entirely with the pasted text.

• If a source file that contains errors or warnings is added to the project as a link, it is now correctly
displayed in Solution Explorer with the error or warning icon instead of the link icon.

• If you created a virtual folder in Solution Explorer and specified file extensions for that folder that
matched the extensions of existing items in the project, the new folder could not be expanded to view
the files it contains.

• The members generated by the Implements Smart Tag are no longer inserted in unsuitable locations in
the code when the expanded copybook view is turned on in the editor.

• Show All Copybooks would not show a copybook if, though it itself could be shown, it contained
copybooks, all of which could not be shown inline.

• The following new default virtual folders are available in this release for non-Mainframe Subsystem
projects - Content (for HTML and ASPX pages), Styles (for CSS stylesheets), Scripts (for JavaScript),
Images (for bitmaps such as JPEG and PNG). For projects where you have created your own virtual
folders, or have moved files between the virtual folders, your changes will be preserved and will override
the new defaults.

• When adding existing files to a managed COBOL Mainframe Subsystem project, the Add Existing Item
dialog now includes filters that enable you to only show the supported file types.

• The options in Tools > Options > Text Editor > Micro Focus COBOL are now set correctly after
installing or updating the product.

• Changing the Build Action property for a file in a project configured to compile to multiple executables
no longer causes a rebuild of the entire project.

• Sometimes, when showing copybooks inline, it was not possible to enter anything at the start of the line
immediately following the end of the expanded copybook.

Web Service Client

Back to the list

• Support for nested COUNT IN clauses has been added to the generated Web Service Console Client.
Empty and unused array fields will no longer be returned in the client output.

2278428 (1066547)

XDB Server

Back to the list

• MFDB2UNL.CBL now allows the use of semi-colons within SQL statements.

2661513 (1090755)

XDB: Problems not classed above

Back to the list
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• Previously, TESTCOVER configuration could cause spurious errors in XDB utilities.

2677742 (1092299)

XML Syntax Support Preprocessor

Back to the list

• PREXML now handles conditional compilation correctly.

2665552 (1091113)
• An XML file being opened for input is now closed correctly.

2664760 (1091006)

XML Syntax Support Runtime

Back to the list

• The XML run-time system now handles non-US EBCDIC characters correctly.

2665518 (1091086)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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